CYCLIC DIRECT SIMPLE SHEAR TESTING

© 2013 Geocomp Corp.

Frequently Asked Questions
Hardware
1. Q: When I view the system before starting the test, there is always about ±0.005 kN
(0.1 lb) load in either the vertical or horizontal load cell. The load cells are at zero load
(no contact). Why there is a small fluctuation in the load, and how can I make it zero?
A: There is always going to be a small load fluctuation of about 0.025% of load cell full
capacity.
To re-zero the load cell, please follow these steps:
1. Go to the System Monitor, and record the analog reading of the vertical load cell when
the load cell is not in contact with anything.
2. Go to Calibrate Summary.
3. Overwrite the Offset value for the vertical load cell with the analog reading value from
step one.
4. Click on the Apply and Ok buttons.
5. You should now see in the System Monitor that the vertical load cell is virtually zero.
Notes:
1. Repeat the same process for the horizontal load cell
2. The horizontal and vertical displacement sensors do not need to be re-zeroed, as the
SHEAR5:CYCLIC program automatically re-zeros them at the beginning of the test.
2. Q: The load frame platen moves down during the consolidation phase until it triggers
the lower limit, at which point the test stops, and an error message appears on the screen
indicating that the lower limit switch is on. Why is this happening?
A: There may be a non-zero vertical load at the start of the test that is higher than the
load in the first step in the Consolidation Table. Go back and re-zero the vertical load cell.
3. Q: During the shear phase, I noticed that my displacement rate is slightly different than
the one that I specified in the Shear Table. Why is that? How can I set it up correctly?
A: The difference in the displacement rate between the specified one and the actual one
can be attributed to the following:
1. The horizontal displacement transducer calibration may be off. Check the calibration
factor and if necessary recalibrate the displacement transducer sensor.
2. The horizontal load step multiplier may need to be adjusted. Assuming that the
calibration factor for the displacement transducer is correct, then follow these steps
to adjust the horizontal load step multiplier:
1. Manually run the ShearTrac-II-DSS horizontally until the horizontal displacement
transducer reads around 30000 counts.
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2. Go to the View System Monitor and record both the pulse count for the horizontal
load motor and the horizontal displacement reading.
3. Now run the ShearTrac-II-DSS until the horizontal reads around 40000.
4. Again record both the pulse count and the horizontal displacement reading.
5. Compute the horizontal load step multiplier as follows:
Horizontal Step Multiplier = Δ Horizontal travel /Δ Pulse count
6. Adjust the load step multiplier accordingly.
4. Q: We have several units connected to the same PC. We were running only one of the
units, so we shut off the remaining units. Then we got an error message stating that the
unit was not responding. It seems that we lost communication with the unit. What is
happening?
A: A temporary loss of communication is a normal thing when you either shut off or boot
up another unit connected to the same network. Any time a unit connected to the network is
powered down or powered up, the network goes into a re-configuration mode, during which
no communication is allowed. Depending on how many other units are on, this process may
take some time. If you're lucky, the Windows software will miss it. If you're not so lucky,
you get the normal 'LoadTrac not responding' message. All you have to do is hit the Retry
button and you should be all set.
5. Q: I noticed that the engineering readings on the LCD screen are different than the
ones on the PC screen. Are they supposed to be the same? Did it affect the results of a
test I just ran?
A: SYNCHRONIZING LCD AND PC SCREENS:
First, I would like to assure you that the mismatch of the engineering readings values
between the LCD and the PC screens will not affect the results of any test that you have run
through the PC software program.
Assuming that your calibration factors are correct, or that you have just finished a new
calibration and need to update the calibration parameters on the embedded controller of a
LoadTrac-II-DSS or FlowTrac-II-DSS or the ShearTrac-II-DSS, you can synchronize the
engineering readings between the LCD and the PC screen by following these steps:
1. Go to the Calibrate Summary menu

2. Select the sensor that you want to synchronize
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3. Click on the Download button. This will automatically transfer (copy and save) the
current calibration parameters (Factor and Offset) into the embedded controller.
4. Repeat the above procedure for the other sensors.
You should now see that the PC and LCD screen values match.
6. Q: I calibrated my transducer and filled out the Calibration table under the Options
menu. However, I can't get the program to save the new calibration numbers. When I
open the file back up the old calibration numbers are still there. How do I save the new
calibration data?
A: Go to File>Save As. Save the file under a new name such as newtemplate.dat
7. Q: After an electrical power problem, it seems that the system is not working properly.
We suspect that the set-up values on the embedded controller are not correct. How do
we revert to the original set-up values or default values set at the factory?
A: The default values may change either after an electrical power problem or due to
inadvertent actions by the end user.
You will need to revert back to the internal default values of your system by following
these steps:
1. Turn off the ShearTrac-II-DSS unit.
2. Wait about 10 sec.
3. Turn it back on and immediately press the ESC key on the keypad to reset everything
back to the imbedded controller default values.
4. Now go to your ShearTrac-II-DSS hardware manual. In each of Sections 2.1.4 and 2.2.4
(Setup sections) you will find a table of default settings for your system. Got through
each LCD menu and be sure the settings on the menu agree with those in the table. If
a setting does not agree, change it to the one in the manual.
5. If the Node ID numbers on your unit were changed (because you are controlling more
than one unit with your computer), set them to the values they were changed to.
(The default values are 101 for vertical control and 102 for horizontal control.)
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Software
1. Q: When I use report software, I cannot change the scale as I want. For example, if I
want to change the vertical displacement scale to negative 0.02, it will not change, but if
I change it to negative 0.2 it will change. (In this particular case the default minimum
value is negative 0.05). A similar thing happens to normal and shear stress scales too.
A: The software tries to keep both the vertical and horizontal scale in a ratio of 1:1 so
that the Mohr circles are actually circles not ovals.
Thus, there are values in the scaling that are not acceptable to the software.
You may have to keep on trying different values.
2. Q: I noticed that for some very soft soil, it takes longer than one second for the vertical
load to reach the specified load. Why does it do that?
A: Because of the stiffness of each soil type, you may need to adjust the vertical load PID
(Proportional Integral Derivative) parameters control. These are under Options/PID/ Vertical
Load.
The PID control parameters are adjustable due to the nature of the different soil types
and large variations in their stiffness, from very soft peat and organic soils to highly over
unconsolidated clays or even soft to medium rocks.
The max PID value is 5.00 (soft soils) and the minimum is 0.10 (stiff soils). The best way to
adjust this value remains by trial and error during the testing.
PID CONTROL
Control of the load application is accomplished by using a closed loop controller. At
equally spaced time intervals called the control loop period, the controller compares the
target load to the measured load. The loop error is the difference between the two. The
controller uses this error to compute and send a signal to the micro-stepper motor in order to
make adjustments to reduce the error by the next loop period.
The signal to the micro-stepper controls the micro-stepper’s position. The loop error
computed by the controller at every loop period is the additional required load to eliminate
the error by the next loop period. In other words, the load rate is the error divided by the
loop period.
Signal = Error/Loop Period/Stiffness
GP = 1/Loop Period/Stiffness
Signal (P) = GP * Error
The above equation is the basic idea behind any proportional controller where GP is the
proportional gain.
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The controller employed by this system is actually a PID controller, where P is for
proportional control, I is for integral control and D is the derivative controller.
3. Q: After running a successful test we ran into troubles with the report. We were not
able to generate a report because all links on the report pull down menu are inactive.
Are we missing something, or is the software not entirely installed?
A: Once a test is finished or even while it is running:
1. Go to the File menu.
2. Click on Load; this will load the test data on the open window on the desktop.
3. Go back to Report. You should see now the Graph, Settings, and Edit menus all
activated.
4. You can change units and scales, and edit the test data points.
5. Remember that every time you change or edit something, you will need to save the
file, and load it again.
4. Q: We are having a problem running the report on one of our tests, and I was hoping
you could offer your insight on the situation. The shear phase of the test was started and
ran for 1.65 minutes, at which time we realized that it was not running at the desired
rate. We then proceeded to enter in the desired rate as step 2 in the shear phase and
told the program to go to the next step, which it did with no problem. We were then
running at the desired rate for the remainder of the test. Our problem comes in that we
cannot get the report function to load up step 2 of the shear phase, so our report is
noting 1.65 minutes to failure at a maximum shearing load of around 8 psf. This is not
the correct data and therefore does not lend itself to the phi angle and cohesion
calculations necessary for what we are doing. Is there a way to get the program to accept
ALL of the shear data, or at least the 2nd step, so we can use the report function? This
data is saved as part of the file, as we can view it in table format.
A: The new version of the SHEAR5:CYCLIC program has a new option to report multiple
steps within the shear phase.
5. Q: Can the software detect wrong values that are manually entered by the end user?
A: Yes, the software program detects any erroneous data entry. Examples include:
1. Negative values for sample dimensions, calibration factors, and PID
control parameters
2. Zero values for sample dimensions, calibration factors (except for offset value), and
PID control parameters
3. Wrong Node ID number
4. A malfunctioning sensor that it is giving an analog reading of either 0 (the minimum
value) or 65535 (the maximum value)
5. Any unit (LoadTrac-II-DSS, FlowTrac-II or ShearTrac-II) that is not on.
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6. Q: I am running a test. Do I need to wait until the end of the test to see the results?
A: You do not need to wait until the end of the test. While the test is running:
1. Go to the File menu.
2. Select Load.
3. Go to the Report menu. You should now be able to see the partial data up to the
point when you did the Load.
5. Repeat the above steps as the test progresses.
7. Q: In many of our different test files, the calibration values in the Summary Table and
the values in each sensor's individual calibration table are not in sync. Could you please
explain which values the program uses, and how to make sure they are correct?
A: All of the Geocomp Corp. control programs have similar menus for performing
the calibration of any of the sensors related to the test. However, you must then copy
the calibration that you obtained into the Summary Table. (If you have had to repeat the
calibration procedure, be sure to use the correct value.)
The calibration factors in the Summary Table are the ones that the particular
program uses when running a test.
Note that it is possible to have no calibration data in the calibration menu if you calibrate
a sensor with one program (for example, ICON) and later use a different program (for
example, SHEAR5:CYCLIC): Each program will always uses the calibration factors contained in
its Summary Table.
8. Q: Why is my final saturation value higher than 100%?
A: This value is sensitive to several factors:
•
•
•

The specific gravity of the sample
The water content
The exact measurements of the inside diameter and height of the ring. (For
instance, the diameter may be 2.489 inches instead of 2.500 inches, and the
height may likewise vary. We recommend using precise calipers to measure
the dimensions of the ring. This should only have to be done once.)

9. Q: How do I increase the responding time for the loading in the consolidation ?
A: According to ASTM standard D2435: Standard Test Methods for One-Dimensional
Consolidation Properties of Soils Using Incremental Loading 1
Section 6.0
“Load application generally should be completed in a time corresponding to 0.01 t100 or
less. For soils where primary consolidation is completed in 3 min, load application should be
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less than 2 s.”
It is easy to increase the response time of the closed-loop control by increasing the PGain under Options PID.
The higher the P-Gain the faster the load is applied; however the control may overshoot
the target load depending on the stiffness of the soil.
This gain can be changed on the fly
while the test is running if further fine-tuning of the control is deemed necessary.
You
should use increments of 0.5 or less at a time. The trade off is that when a load specially a
high one is applied rapidly, the soil if it is a very soft one can be “shocked” and it is a very
stiff one, the load may take time to converge to the target value by a steeper over and under
shots.
Sample stiffness
LOOSE /VERY SOFT
MEDIUM SOFT/MEDIUM
DENSE/STIFF

Recommended P-Gain
value
5.0
2.5
0.5

The default values are the recommended values that should work fine with the majority
of soils. The following diagrams illustrate the effect of the PID control on different soils
stiffnesses. See illustrative graphs.
Soft or Loose Soil Samples; Load or Pressure vs. Response Time:

P-Gain = FAST

P-Gain = SLOW

Stiff or Dense Soil Samples; Load or Pressure vs. Response Time
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P-Gain Low = SLOW

10. Q: The software manual says that the Proportion Gain can be as high as 5 for soft soils
and as low as 0.5 for stiff soils. Also, the Integral Gain should probably be set to 0.1 for
very stiff samples. What other values might be used and how are we going to decide on
the best values to use? Please clarify.
A: It is possible to use any Proportional Gain (P-Gain) value from 0.5 to 5 and any Integral
Gain (I-Gain) from 0.1 to 1. (The Derivative Gain value of 0 should not be changed.) The rate
at which a load is applied at the beginning of a step depends on both the P-Gain and the IGain: lower value = slower rate, higher value = faster rate. The time to reach a target value
increases by a factor of about 3 from a P-Gain of 0.5 to 5.
In addition, the following information may help you to decide what value will be best for
your sample.
The graphs shown below are for loading curves generated during a test. (They were
generated from data dumped into a file after the test.) Note that the time scale is not the
same for the different soil types. When possible, the target load/pressure should be reached
in less than 0.5 min. Consequently a high P-Gain setting is good for very soft soils.
It is easy to reach the target load/pressure value for stiff soils. However (as seen in the
last two graphs), the target value may not be reached smoothly. To help this situation, the IGain (or both the I-Gain and P-Gain) can be decreased.
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In addition, a “rule of thumb” for response time is given in Section 6.0 of ASTM standard
D2435: Standard Test Methods for One-Dimensional Consolidation Properties of Soils Using
Incremantal Loading.
“Load application generally should be completed in a time corresponding to 0.01 t100 or
less. For soils where primary consolidation is completed in 3 min, load application should be
less than 2 s.”
To find out what the T100 value is for a step in a test, open the Test T100 window (by
choosing the T100 option in the View menu) at the beginning of the step. As soon as the
ICONP program has gathered enough information, it will show the graphical determination of
the T100 value on the window. It will also list the T100 value in the Test Monitor window.
To change a PID setting click PID on the Options menu to open the Load PID Settings
window. Replace the default value with the new value, click the Apply button and then close
the window.
11. Q: How is the excess pore water pressure ∆u measured during the shear phase?
A: The shear phase of a Direct Simple Shear test is run under active height control
according to ASTM Standard D6528, section 3.2.1. whereby the height of the specimen is kept
constant through feed-back control of the vertical displacement. The sample area is
constrained by the stacked rings which results in a constant volume. The change of vertical
stress 
n is the shear induced pore pressure:
where:

∆ u = σ’nc – σ’n
σ’nc normal consolidation stress at the start of shear

12. Q: Why is the applied stress amplitude different than the specified one in the cyclic
table? For example, we have 100 kPa as the consolidation stress and a stress ratio
amplitude of 0.5. Using the equation in the manual the shear stress amplitude should be
25 kPa, or ± 12.5 kPa but our shear stress as displayed is between 10 and -10 and in
another test it is -8 and 13.
A: The vertical force is changing during cyclic to keep, therefore the shear shear changes
accordingly to maintain the stress ratio constant.
13. Q: We are getting better results at low frequencies less than 1 Hz than higher ones.
What is the highest frequency that we can run our tests and still controlling the specified
stresses?
A: There is no ASTM standard for the cyclic direct simple shear but previous work in the
literature has been done with frequencies of 1 Hz or even lower. See for example paper by
William H. Peacock and Bolton H. Seed, “Sand Liquefaction Under Cyclic Direct Simple
Shear.”
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It is however obvious that the slower the frequency the better the control of the stresses.
14. Q: The PID values do not change on the control panel when their values are altered in
the software.
A: The software program overrides the all the settings as shown on the LCD screen in the
hardware frames including the calibration factors. The values shown on the computer are the
ones that control the test.
15. Q: Although the Instruction Manual advises not to change the default PID values, the
Troubleshooting section at the end of the manual suggests different PID values for use
with soft and hard samples? Is it possible to use other values than the three choices
given? If so, how are we going to decide on what values to use? Please clarify.
A: The default values work for most of the soils; however in some case they do need to be
fine-tuned to reflect the soil out of the normal range of stiffness such as for soft organic or
highly stiff clays. So yes, you can change them by exercising caution (small increment in
change at a time) in doing so.
16. Q: What are the effects and correlations between the PID values?
A: Effects of each of controllers P-Gain, D-Gain, and I-Gain on a closed-loop system are
summarized in the table shown below.
CL RESPONSE

RISE TIME

OVERSHOOT SETTLING TIME

S-S ERROR

P-Gain

Decrease

Increase

Small Change

Decrease

I-Gain

Decrease

Increase

Increase

Eliminate

D-Gain

Small Change Decrease

Decrease

Small Change

Note that these correlations may not be exactly accurate, because P, I, and D are
dependent of each other. In fact, changing one of these variables can change the effect of
the other two. For this reason, the table should only be used as a reference when you are
determining the values for P, I and D.
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